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DISCLAIMER:   

This user guide is for training purposes only.  The information contained in this user guide is current at the time of 

publication.  It can be used to reference and may be subject to change. 
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What are merlot’s applications? 

The merlot.aero suite is a complete organizational management solution offering all aspects of airline resource planning 

and control to ensure the safety, efficiency and quality of your crew and operational environment.  

 

merlot.aero is a comprehensive suite of applications, covering all aspects of your airline needs. It has been developed 

with the entire business process in mind; including the customer process from the moment ticket sales are planned until 

the point the passenger reaches their destination. 

 

For your convenience merlot applications are divided into two main categories: 

• Aircraft Applications 

• Crew Applications 

 

There are a number of applications under these two main categories.   

 

Aircraft applications include: 

• AircraftSchedule   

• AircraftFollow 

• AircraftPortal 

 

Crew applications include: 

• CrewPlan 

• CrewBuild  

• CrewRoster  

• CrewPortal 

• CrewMonitor  

• CrewFollow   

• CrewPayroll  
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FrameWork Applications 

The merlot.aero suite of applications eliminates the use of text commands by employing a Graphical User Interface (GUI). 

You are presented with the following options available in all applications across the merlot.aero suite. 

 

 
 

These are Framework Applications that will follow you throughout the merlot suite.   

 

This icon is the Job Engine.  If red, this means the job engine has stopped. If green, the job engine is running. 

 
 

This icon is the signal strength of your connection to the Internet. 

 
 

The Memory Monitoring tool displays memory utilization for merlot applications in real time. 

  
 

Memory utilization is displayed in three different levels: 

 

Icon Level Range 

 

 

 

Low (Green) 

 

 

0MB-700MB 

 

 

 

 

Moderate 

(Yellow) 

 

 

701MB - 1000MB 

 

 

 

 

High (Red) 

 

 

1001MB and above 

 

 

Hovering the mouse over the tool icon displays the following information: 

 

• Icon label - Memory Monitor 

• Memory consumption in MB with KB conversion e.g. 64 MB (65660 KB) 

• Level of memory consumption e.g. Low 
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This icon is Ad Hoc Reports. Ad hoc reports are available in all the applications and modules across the merlot.aero suite 

while specific application reports are available in the Reports dropdown menu. 

 
 

 
 

This icon is the Shift Log.  You can add notes to the Shift Log for any system user to view. 

 
 

 
  

This icon is to Add Task.  Set a daily or one time reminder for everyday activities (i.e.: Accommodation Check). 

 
 

This icon is to send documents. Send a document to a crew member or to a fellow merlot.aero user.   
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This is the mail icon.  Send messages to crew or co-workers via SMS, email or directly within the merlot.aero suite. 

 
 

 

This icon allows you to navigate through the entire merlot.aero suite. 

 
 

When the application setting UseUIDebug is set to True, the New Activity Log menu will be visible under the Login Centre 

and available for use. All incoming Merlot UI Error Logs will not be displayed in the existing error log in the application nor 

trigger the alert unless the error is related to Insert/ Add/ Delete rows. 
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Example of a collapsed Activity Log form: 

 

 
 

When a user expands the log value, the complete details of the selected UI error log will be displayed. 

 

Example of an expanded Activity Log form: 
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What is AircraftSchedule? 

AircraftSchedule is part of the merlot suite of planning applications. AircraftSchedule improves the development of flight 

schedules, meeting the needs of airlines for increased efficiency in scheduling while ensuring operational integrity. The 

application includes a maintenance planning capability.  

 

In AircraftSchedule, system users either import a Standard Schedules Information Manual (SSIM) or create a new 

schedule. Once all the flights are in the schedule, the schedule is marked active and is ready for next stage development 

of pairings in CrewBuild.  

 

AircraftSchedule Audience 

AircraftSchedule system users are airline employees who work as flight schedulers and flight planners at scheduled 

airlines. AircraftSchedule users are actively involved in the process of schedule planning; either creating and/or importing 

flight schedules for a specified time period. 

 

AircraftSchedule Prerequisites 

Prior to undertaking tasks in AircraftSchedule, it is first necessary to define the route structure in the Configure 

application. In addition, Configure is where equipment types, equipment registration and turnaround times are defined as 

well as ports and on time performance (OTP) parameters. See the Configure User Manual for more information.   

 

Logging into AircraftSchedule 

With your merlot.aero credentials simply log in and select AircraftSchedule. 

 

 
 

 

The Graphical User Interface (GUI)  

The merlot.aero suite of applications eliminates the use of text commands by employing a Graphical User Interface (GUI).   

Let’s explore the AircraftSchedule GUI: 
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The following features of the GUI are available only after a schedule has been created: 

 

1. Tool Bar: Contains application icons that give you access to commonly used AircraftSchedule functions. 

2. Filters Panel: Sets the criteria to find flight instances from within the flight schedule in the Schedule Display 

Panel.  

3. Schedule Display Panel: Display the schedule where you can view, add and edit flight instance schedules, 

either in grid or Gantt view, and tests schedule alternatives in the PlayPen with an option to save the changes.  

4. Application Footer:  A non-interactive bar at the bottom of the Schedule Display Panel which contains 

information relating to open schedule data in the Schedule Display Panel. 
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Scheduling Functions 

This section provides users with an overview of merlot.aero application panel functionality in order to perform 

AircraftSchedule tasks detailed later in this manual. The panels that are displayed include the Filters Panel and the 

Schedule Display Panel as well as AircraftSchedule toolbar. 

 

AircraftSchedule Toolbar 

 

The AircraftSchedule toolbar is located immediately below the menu bar. The toolbar allows you to access commonly 

used functions. Details each icon are listed below.  

 

Icon Used for   Icon   Used for 

 

Create New Schedule 

 

   Add Flight  

 

Open Schedule 
 

 Add Cycle 

 

Save Schedule 

 

 Flight Information 

 

Save Schedule As 
 

 Delete Flight  

 

Print Schedule 
 

 Find 

 

Mark as Active Schedule 

 

 Schedule Conflict  

 

Delete Schedule 

 

Reports – Application specific  

A future development feature in 

AircraftSchedule. 

 

Close Schedule 

 

 Help  - Same as the help resource 

 in Login Centre   

 A future development feature in 

 AircraftSchedule. 

 

The application toolbar quickly facilitates task completion in AircraftSchedule. Some of the same functionality is also 

available in the menu bar (such as File, Edit and View), giving users the flexibility to access features based on user 

preference. 

  



 

2018 | COMMERCIAL IN CONFIDENCE | Page: 14 of 59 

Filter Panel  

The purpose of the Filter Panel is to enable users to find flight instances in the schedule by searching for flight schedule 

components such as ports, equipment, routes and operators, and display these instances in the Schedule Display Panel. 

 

 

The Filter for the Schedule Display Panel is grouped into the following sub-

sections: 

• Filter Management 

• Standard Criteria  

• Advanced Criteria 

• View the Data 

 

 

Filter Management  

 

Filter Management is used to manage new and existing filters. You can choose 

an existing filter, save a new filter criteria, or delete an existing filter. 

 
• Saved Filters List: Selects an existing filter criteria. 

• New Filter Textbox: Accepts the name of the new filter criteria.  

• Save Button: Saves the new filter criteria. 

• Delete Button:  Deletes the selected filter in Saved Filters menu. A 

confirmation is required before the filter is deleted. 

 
 

 

   

                        

Standard Criteria  

 

The Standard Criteria filter section is used to determine the data to be displayed in the Schedule Display Panel. The 

section is composed of the following options: 

• Designator List: Displays airline designator codes. If a carrier has more than one airline in their group, the menu 

shows all active airline codes. 
• Operator List: Displays airline operator codes. If a carrier has more than one airline operator certificate, the 

menu shows all active operator codes.  

Note: Designator and operator codes and ports can display either IATA or ICAO codes. By default, IATA codes are 

used. If your company requires using the ICAO codes, please contact Customer Support. 

 

• Equip Type List: Displays the active aircraft type(s). 
• Equip Rego List: Displays the active aircraft registration(s) or tail numbers. 
• Route List: Displays the airline’s active routes. 
• Departures from List: Displays departure ports. 
• Arrivals into List: Displays arrival ports. 

• Reset Button: Clears and restores the filter options to default. 
• View Button: Displays filter data based on the filter options in the Schedule Display Panel. This enables the user 

to make multiple modifications to filter criteria and then have them applied to displayed data at the same time. 

NOTE: Leaving a field blank in any filter panel includes all options for that field. 
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Advanced Criteria  

 

The Advanced Criteria section contains the following options: 

 

 
 

• Turnaround minutes: The turnaround times (TAT). To filter a TAT, enter the time values in minutes. 
• Filter: Selecting this option will display only the flights that adhere to the filter criteria above. All other flights will 

not be displayed. 

• Highlight: Visibly highlights flight instances in the Schedule Display Panel based on user selected criteria 

 

  

Schedule Display Panel   

The Schedule Display Panel displays flight schedules. The Schedule Display Panel enables airline schedulers and flight 

planners to create and edit flight schedules.  

 

 

Schedule Display Panel Tabs  

 

 
 

The Schedule Display Panel consists of three views: 

• Schedule: Displays flights in a tabular layout. 

• Gantt: Displays the flights in a Gantt chart. 

• PlayPen: This mode is used to draft flight schedule changes before saving them. This will be developed in the 

future. 
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Schedule View 

 

 
 

 

The Schedule view displays flight instances within the flight schedule and facilitates the efficient creation and 

modification of flight instances. Each row in the table represents one flight and its instances within the schedule period.   

The following are the columns in the Schedule Display Panel: 

Column Description 

Equipment Type Aircraft model  

Flight Flight number 

Designator Airline designator 

Instance Date Date of flight, if only one instance is required in the period 

Effective From First date of scheduled flight instance, if recurring within the period 

Effective To Last date of scheduled flight instance, if recurring within the period 

Route Type Defined route type such as Domestic, International or Charter 

Route A course between two ports 
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Column Description 

STD Scheduled time of departure (STD) 

STA Scheduled time of arrival (STA) 

Every Day When the checkbox is selected, the flights operate every day of the week. 

M T W T F S S Days of the week Monday – Sunday 
Individual days of the week are selected by pressing the check box in the designated day of 
the week column. This indicates the days during the period when the flights are recurred. 

Onward Flight Next flight in the flight sequence 

Cycle Number The cycle number represents a complete line of flights for one aircraft within the schedule 
period 

Turn Around Turnaround time between arriving flight and departing flight. This is automatically filled out if 
the flight has an onward flight.  

View Flight 
Information icon 

View Flight Information. Displays more details on the selected flight. 

 

Add Cycle icon 

Add Cycle. Adds a row for a new cycle or line of flight.  

 

Add Flight to 
Cycle icon 

Add Flight to Cycle. Adds a row for a succeeding flight.  

 

 

Note: The column order can be reorganized according to your preference. Simply drag the columns to your preferred 

position in the tab. 
 

Gantt View 

To display the flight schedules in Gantt view, click the Gantt tab. 

 
 

The Gantt view presents flights graphically in a Gantt or bar chart format. Flights are displayed as rectangular objects, or 

pucks, which are aligned along a horizontal axis called the Cycle Line. To view the flight schedules in detail, hold the Ctrl 
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key and drag the timeline header either to the left or to the right. You can also use the icons below the header to zoom in 

or zoom out, or to move through the times/dates displayed in the Gantt view. 

 

 

Flight Data Elements  

 

 

Note: Start reading from left to right.  

Data Element Description 

Departure Port The departure port of the sector (for example: PER). 

Turnaround time Amount of time on ground between two flights (for example: 01:10) 

Departure Time Scheduled time of departure (STD)  

Flight 

Designator/Flight 

Number 

The operating airline designator followed by the flight number (for example: TZ 7). The 

designator can be configured to be displayed or not. 

Arrival Time Scheduled time of arrival (STA) 

Arrival Port Arrival port of the sector (for example: YPA).  

 

 
Routes 

To access routes, click on the red Routes link under the Application Icon tool bar in the Schedule Display Panel. This 

comes in handy when flights for a new route will be scheduled but the route has not been created yet in Configure. 

From the Route form, users can find routes as well as add and delete them.   
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Users must have security rights to add and delete routes in the system.  

 

Find Route 

To locate a route using the Route form: 

1. Enter the Route name and select Route Type from the dropdown field. 

2. Select the Show Active check box to display active routes 

 

View the corresponding routes from the designated departure port (i.e., airport) in the grid as shown above. 

 

Alternatively, select a letter corresponding with the name of the departure port from the alphabet (A-Z), or select All and 

view the corresponding routes in the grid.  

 

Click Cancel to close the form. 

 

 

Add Route 

 

To add a route using the Route form: 

1. Click on the Add button at the bottom of the Route form 

 

A new row is inserted in the grid, as shown in the example above. 

 

2. Enter the following fields: 

 

Field Description 

Route  Enter the departure and arrival codes as one word, for example ATLLAX 

Departure Port The departure port will automatically populate with the name of the airport 

Arrival Port The arrival port will automatically populate with the name of the airport 

Route Type Select a defined route type i.e. domestic, international or charter from the dropdown 

field 

Primary Primary checkbox, leave as unchecked  
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Active Select the Active check box, if this is an active route 

 

3. Click the Save button to save the route or the Cancel button to close the form without generating action       

 

 

Delete Route 

To delete a route, locate the route for deletion. Click on the row for deletion and click on the Delete button. 

 

 
 

A delete dialog box will ask you to confirm the deletion. Click on the Yes button to delete or the No button to close the 

dialog box without generating action. 

Flight Display Panel Application Footer 

The Application Footer is a fixed, non-interactive bar at the bottom of the Schedule Display Panel which contains 

information relating to the data open in the Schedule Display Panel, including number of flights in the schedule and flight 

frequency information, block hours and utilization statistics. 

 
 

The Application Footer fields are as follows: 

Field Description 

Days Number of days in the schedule period  

Flights Number of flights operating during the defined schedule period 

Block Hours A measure of the total flight hours for the given schedule period 

Utilization A measure of aircraft productivity calculated by dividing block hours by number of aircraft 
assigned to service.  
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Flight Information  

The Flight Information window is a pop-up window that gives users access to flight details from the Schedule Display 

Panel. In this window, users can add, delete and edit flight information.  

 

The Flight Information Window (FIW) can be accessed as follows: 
 

• Double click a sector or flight leg in the Flight Gantt  

• Select a flight in the grid, click on the Flight Information icon  in the Application Tool Bar 

• Click on the View Flight Information icon  in the Schedule Display Panel – Schedule View 
• Click Flight Information from the Edit menu tab 

 

 

Flight Information Links 

 

There are a number of links available at the top of the FIW. All of these links provide useful information about the flight 

and access to editable data fields. The links and link descriptions from left to right are described below. 
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Schedule Leg Complement Delta  

 

The Schedule Leg Complement Delta form allows the user to add and delete the required crew complement for the flight. 

This adjusts the required number of crew if it deviates from the default requirement like in long haul flights. 

 

 
 

The field descriptions are as follows: 

 

Field Description 

Effective From The Effective From date is the date the schedule starts. This information is prepopulated 

from the Schedule Display Panel, when a new row is added 

Effective To The Effective To date is the date the schedule ends. This information is prepopulated from 

the Schedule Display Panel, when a new row is added 

Days of Week The days of the week the flight operates, if in a recurrence. This information is 

prepopulated from the Schedule Display Panel, when a new row is added 

Equipment Rank 

Complement 

The list of ranks associated with the equipment type of the flight.   

Complement Displays the default flight crew complement for the selected equipment rank complement 

Is Delta Select the Is Delta check box to make a change in the complement default number. 

Complement Delta Enter the value of the complement change, either a positive or negative number to reflect 

the change in the number of crew required for the flight. The outcome of the above 

example is one additional cabin crew. 

 
To complete the Schedule Leg Complement Delta form: 

1. Click the Add button to add a new row.    

 The Effective From/To dates and Days of the Week are automatically added based on the flight schedule.  
2. Select a rank from the dropdown Equipment Rank Complement menu 

In the Complement field, the default number of crew will display. 

3. If changes to the complement are required, select the check box in the Is Delta column. 

4. Indicate the required number change in the Delta Complement field by using the up/down arrows.  

5. Click the Save button. 

To delete information in the Schedule Leg Complement Delta form, select a row with complement data and click the 

Delete button. Click the Yes button to confirm the deletion and the row is removed from the form. 
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Schedule Leg Flag 

The Schedule Leg Flag form allows users to add an informational flag against a flight. For instance, a flight may be 

flagged as a training flight.  These flags will be displayed in AircraftFollow and AircraftPortal. 

 

To complete the Schedule Leg Flag form: 

1. Click the Add button to add a new row.    

The Effective From/To dates and Days of the Week are automatically added based on the flight schedule.  

2. Select the number of flags from the Flag column, using the up/down arrows.  

3. Add applicable comments in the Comment field. 

4. Click the Save button, followed by the Cancel button to return to the Flight Information window. 

To delete information in the Schedule Leg Flag form, select a row with existing flag data and click the Delete button. 

Click the Yes button to confirm the deletion and the row is removed from the form. 
 

Schedule Leg Known As 

The Schedule Leg Known As form allows the users to create another reference to the flight. This form is often used for 

codeshare flights.   

 

 
To complete the Schedule Leg Known As form: 

1. Click the Add button to add a new row.   

The Effective From/To dates and Days of the Week are automatically added based on schedule dates. 

2. Enter flight reference information in the Flight Reference column, such as training flight for crew or codeshare 

flight. 
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3. Click the Save button. 

To delete information in the Schedule Known As form, select a row with existing flag data and click the Delete button. 

Click the Yes button to confirm the deletion and the row is removed from the form. 

 

 

Schedule Leg Comment 

The Schedule Leg Comment form allows users to add and delete comments from the scheduled leg. 

 

To complete the Schedule Leg Comment form: 

1. Click the Add button to add a new row.    

The Effective From/To dates and Days of the Week are automatically added based on the schedule dates. 

2. Enter flight comment information in the Comments column, such as flight requested by civil authority. 

3. Click the Save button, followed by the Cancel button to return to the Flight Information window 

To delete information in the Schedule Leg Comment form, select a row with existing flag data and click the Delete 

button. Click the Yes button to confirm the deletion and the row is removed from the form. 
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Flight information – Main View 

The Flight Information window (FIW) is a pop-up window that gives users access to all information related to a flight.  
Users can also edit flight information from this window.  Required fields are marked with an asterisk. The presence of a 
down arrow in a field indicates there is a dropdown menu with options for the user to choose from. The up/down arrows 
in a field enable users to edit numerical values. 

 
 

The main area of the FIW displays the following flight specific information (left to right): 

 

Field Description 

Equipment Type Aircraft model  

Flight Flight number 

Designator Airline designator  

Client  Reference to client name, if applicable 

Onward Flight Next flight in fight sequence, if applicable  

Instance Date Date of flight, if only one instance is required in the period 

Service Type Service type such as passenger normal service, military, non-revenue, training  

Seat Config Seating configuration on board the aircraft (F/C/Y) 

Non Revenue Select if the flight is non-revenue i.e. a ferry flight or deadheading flight  

Effective From  First date of scheduled flight instance, if recurring within the period  

Effective To Last date of scheduled flight instance, if recurring within the period 

Information Only Displays aircraft in schedule as an informational instance only. It allows users to track a 

flight in AircraftFollow, not to manage the flight.  This feature is helpful for example with 

deadhead flights.   

Route Type Defined route type such as Domestic, International or Charter 

Route A way or course between two ports  

STD [L] Scheduled time of departure (STD) in local time 

STA [L] Scheduled time of arrival (STA) in local time 
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Frequency Time How many times in a week this aircraft operates 

Cycle No Cycle number representing a sequence of flights 

Departure Gate Departure gate in the terminal, if available 

Departure Terminal Departure terminal, if available  

Arrival Terminal Arrival terminal, if available 

Arrival Gate Arrival gate in the terminal, if available 

Days of the Week Select days of the week the flight operates by selecting applicable check boxes (M T W T 

F S S) 

Once flight instances are updated, click on the Save button, followed by the X button to return to the Schedule Display 

Panel. 

Conflict icons are displayed beside some of the fields if conflicts are found. In the flight displayed above, these are the 

corresponding conflicts: 

 

The Non-standard flight time conflict is raised if the flight time is not the same that is set up for the Route. The Onward 

flight conflict is raised if the onward flight is incorrect, like when the onward flight is scheduled before the current flight. 

The Below Minimum Scheduled Turnaround conflict is raised if the turnaround time between the current and next flight 

does not reach the minimum requirement. 

There are a number of buttons in the Flight Information window to assist users with editing flights. This feature of 

AircraftSchedule enables users to view other flight instances for reference.   
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The button functionality is as follows: 

Button Description 

Prev Flight in Sequence Moves to display the previous flight in sequence in FIW and the Schedule Display 

Panel 

Prev Instance of Flight Moves to the earlier instance of a flight, if recurred 

Next Flight in Sequence Moves to display the next flight in sequence in FIW and the Schedule Display 

Panel 

Next Instance of Flight Moves to the next instance of a flight, if recurred 

Port Requirement* Displays Port Requirement form to view or edit requirements for the departure or 

arrival port 

Route Requirement* Displays Route Requirement form to view or edit requirements for the route 

Save Saves information in the FIW and in the Schedule Display Panel  

Cancel Cancels without saving information entered in the Flight Information window 

* See below for sample Port Requirement and Route Requirement forms with instructions on how to complete the forms. 

 

Port Requirement  
The Port Requirement Equipment form allows users to view, add and delete equipment requirements at a specified port. 

The default set up for port requirements takes place in Configure. Required fields are marked with an asterisk in the 

column header. 

 

To add a port requirement: 

1. Click Add to insert a new row 

2. In the Condition column, choose Must Have, Must Not Have or No Condition, as configured 

3. Select the Equipment Profile from the dropdown menu. 787 Stairs is displayed in the example above. 

4. Select Active From/To dates from the dropdown calendar, if different from the auto-populated dates. 

5. Choose the applicable Rule Level selection including Critical, Critical Planning or Allow Override. 

6. Add any comments in the Comment field. 

7. Select the Active check box to indicate an active port requirement.   

8. Click on the Save button. 

To delete information in the Port Requirement form, select the row for deletion and click the Delete button. Click the Yes 

button to confirm the deletion and the row is removed from the form. 
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Criticality Level Definitions 

 

Allow Override 
User with supervisor or management rights has the ability to override a warning or 

violation 

Critical Cannot be overridden or avoided 

Critical - Planning Same as critical, however occurs during the planning stage only 

 

Route Requirement 
The Route Requirement Equipment form allows users to add and delete equipment requirements for designated routes. 

 

The default settings for route requirements are setup in Configure. Permissions are also set up in Configure and 

determine which system users can add and edit route and port requirements. Configure administrators determine for 

instance, if duty managers can update route or port requirements. 

See the Port Requirement form for detail on how to complete this form. 
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AircraftSchedule Specific Tasks 

AircraftSchedule tasks occur after the flight planning stages, after routes, ports 

and equipment are all defined within Configure. Schedules are manually 

created or imported by system users. 

 

This section provides an overview of AircraftSchedule tasks in a step-by-step 

format. 

 

1. Create a new schedule for a specified date range. Name the schedule. 

 

2. Create flight instances and frequencies in the schedule based on flight 

cycles. 

  

3. Optional: Plan for scheduled maintenance events by reviewing the 

information in the Maintenance Display or Manage Maintenance 

feature. 

 

4. Verify flight rules via the green tick mark. If not green, fix flight errors. 

 

5. Mark the schedule as active.    

 

It is suggested that systems users carefully review the schedule to make sure 

the flights are correct, because once the schedule is marked active you cannot 

change the flights in AircraftSchedule.  All changes must be done in 

AircraftFollow by fixing flights one at a time.  

6. Optional: Export SSIM file   

 

This feature is only used if system users need to distribute SSIM schedules to 

other people. This job runs in the background and is exported to an FTP file to 

a location designated by the user.  

7. Pull AircraftSchedule specific reports, as required. 

 

Alternative Steps (based on importing an SSIM file): 

 

1. Import an SSIM file.  

 

2. Review imported flight schedule for accuracy. 

3. Mark schedule as active.  

4. Optional: Export SSIM file. 

 

 

The next section will review options available under the File, Edit, View and the Tool tabs in AircraftSchedule to assist with 

aircraft scheduling. 

 

 

 

 

 

AircraftSchedule 

Workflow 

Create a New Schedule 

or Import SSIM file 

Add Flight Cycles and 

Flight Instances 

Plan for Scheduled 

Maintenance Events 

 

Verify Rules 

Mark Schedule as Active 

Export SSIM 

Reports 
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Modifying Active Schedules 

Changes to active schedules can be saved and reflected in AircraftFollow. The steps to update active schedules are as 

follows: via Ad hoc Scheduled Message (ASM) export.  

 

1. Open the active schedule.  

2. Modify the schedule as needed. 

3. Save the schedule.  
The Export Schedule Changes form appears. 

 
 

4. Expand each flight recurrence by clicking the (+) at the leftmost column. 

5. Select the Process tick box for the flights that need to be exported to AircraftFollow. 

6. Click Process to proceed with the changes, or click Cancel to discard changes. 

When the user clicks the "Process" button, the flights will be sent to a configured ASM Export job within the JobEngine. 

The job will process the changes and generate the IATA ASM schedule messages required for processing. 

 

A corresponding IATA ASM Import Job configured in the JobEngine will then pick up the changes and import them into 

the live schedule in AircraftFollow. Once completed, the selected changes will now be visible in AircraftFollow without the 

need to manually update individual flights. 
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Menu Options in AircraftSchedule  

File Menu 

Key AircraftSchedule functions are located under the File menu, including creating, opening and saving schedules as 

well as marking schedules active. These functions will be discussed in detail. 
 

Create New Schedule  

The Create New Schedule feature enables users to create a new flight schedule. Start by clicking on the Create New 

Schedule feature from the File menu. The fields marked with an asterisk are required fields to complete. 

 

 
 
To complete the Create New Schedule form:    

1. Enter a schedule name in the Name field. This field is a free form text field. 

2. Enter the version of the schedule in the Version field. This field is a free form text field. 

3. Select Effective From/To dates using the dropdown calendars. 

4. Select the Master check box to indicate that a Master schedule is being created. 

By selecting the Master check box, the application applies default airline values from the operator and company 

tabs in Configure. 

If the Master check box is not selected, the Schedule Header Master will display, which is useful when there are 

multiple operators, or when the user wants to hand select components in the schedule. Select all the necessary 

options that the schedule requires. 
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5. Enter comments related to the schedule in the Comments field. For example, high season schedule 

6. Click the Save button to create a new schedule or the Cancel button to close the form without generating action 

Note: If an airline typically operates a repetitive schedule, users can import a previous schedule and update the changes. 

The Schedule Display Panel will appear. Users can start adding cycles and flights at this point. 

 

 

Open Schedule  

The Open Schedule feature enables users to open a schedule. Start by clicking Open Schedule from the File dropdown 

menu. This form includes a filter to enable users to quickly find draft and active schedules. 

 

 
 
To utilize the Open Schedule form:    

1. Select Start and End dates to search for a schedule using the dropdown calendars then click the Filter button. 

2. Select the Draft or Active Schedules radio button. 

Draft schedules are schedules in progress that have not been activated (marked active). Draft schedules once 

marked active are displayed as active schedules. Active schedules have been marked active. 

The displayed schedules are included in or overlap with the filter dates selected in step 1. 

3. To open a schedule, select the schedule row, then click the Open a Schedule button or the Cancel button to 

close the form without generating action. 

The open schedule displays in the Schedule Display Panel. 
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Save Schedule  

The Save Schedule feature in the File menu saves schedules in the Schedule Display Panel. If any required fields in the 

Schedule Display Panel are incomplete, the following alert will display: 

 

 
 

Once the designated fields are complete, the user clicks Save Schedule from the File menu and the flight schedule is 

saved. 

 
 

Save As Another Schedule   

The Save as Another Schedule feature enables users to reuse a part of an existing schedule. For example, if the user 

has a July schedule open and wants to save a subset of the July schedule, from July 25th to July 31st, then the 

destination start and end dates can be adjusted accordingly and saved. 

 

This feature is accessed by clicking the Save as another Schedule feature from the File dropdown menu. The steps for 

using the form are enumerated below. Fields marked with an asterisk are required fields. 
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To utilize the Save as Another Schedule form:    

1. Select a schedule from the Schedule Display Panel.  

2. Click on Save As Another Schedule from the File dropdown menu. 

3. Modify the schedule name by entering a name in the Name field. 

4. Update the version by entering the version number in the Version field. 

5. The Effective From/To dates reflect the dates of the original schedule.  
6. Select Destination (Dest) Start/End dates for the new schedule that will have the same flights on the effective 

dates. 

7. Enter any comments related to the new schedule in the Comments field.  

8. Click on the Save button to save as another schedule or the Cancel button to close the form without generating 

action. 

 

The Save as a new schedule dialog box displays. 

 

 
 

9. Click the OK button after reviewing the dates to save as another schedule, or click Cancel to close the dialog 

box without generating action. 

 

Close the form and the current schedule. Go to Open Schedule to view the new schedule. 

 

The Effective From/To dates are the dates of the original schedule. These dates cannot be changed outside of the 

original constructed schedule dates. The Destination Start/End dates are the dates of the schedule being saved as a new 

schedule.  

 

 

Mark as Active Schedule 

The Mark as Active Schedule feature enables users to activate a flight schedule which makes the schedule accessible 

for next stage development in CrewBuild and AircraftFollow.   

 

The Mark as Active Schedule can be accessed in AircraftSchedule from the File menu under Mark as Active Schedule. 

The form includes a filter function to locate the schedule for activation. 

 

 
 
To complete the Mark as Active Schedule form:    
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1. Filter for the schedule to be marked as active. Follow the same steps in Open Schedule. 

2. To mark a schedule as active, select the desired row. Click the Mark as Active button or the Cancel button to 

close the form without generating action. 

The Active Flag Window displays. 

 

 
 

3. Enter the Start/End Dates of the active schedule using the dropdown calendars. 

4. Choose Planned, Active or Provisionally Active from the dropdown menu. 

5. Click on the Mark as Active button to activate the schedule or the Cancel button to close the form without 

generating action. 

 
The following alert displays: 

 

Click OK. A message will be sent in the user’s inbox when the job is finished processing. 
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The schedule now displays as an active schedule in AircraftSchedule, and flight sectors are now accessible in 

CrewBuild and AircraftFollow.  

 

 

Administrator Note 

The Mark Schedule as Active Job (MarkScheduleActiveJob) must be set to active and has the correct 

database credentials. Also, the user preference EnableScheduleActivationUsingJob must be set to 

True. 

 

Print Schedule 

The Print Schedule feature can be accessed from the File menu under Print schedule. 
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Delete Schedule 

The Delete Schedule feature enables users to delete a schedule. 

 
 

 
To delete a schedule:  

1. Select a schedule for deletion from the Open Schedule view. 

2. Click on Delete schedule from the File menu. 

3. Click the Delete Schedule button after verifying the correct schedule for deletion, or click the Cancel button to 

close the form without generating action. 

 

The schedule is permanently removed from the list of schedules as well as the Schedule Display Panel. 

 

Note: Only draft schedules can be deleted. 

 

 

Import Schedule  

The Import Schedule feature enables users to import from an existing schedule. For instance, a user may create a new 

schedule for July, then import some flights from the May schedule into the newly created schedule for July. This saves 

the user a lot of time from recreating the same flights. 

 

Start by clicking on Import Schedule from the File dropdown menu while working in the Schedule Display Panel.      
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To locate the schedule to import and start the import process:    

1. Select Start/End Dates of the schedule to be imported from the dropdown calendars.  

2. Select the Draft or Active Schedules radio button. 

3. Click on the Filter button. 

4. Select a schedule to import from the displayed schedules. 

5. Click on Import a Schedule button. 

 

The Import Schedules pop up window includes a filter to enable system users to import specific components of the 

schedule and/or the entire schedule. Designators, Routes and Cycles auto-populate from the imported schedule as 

shown below. 

Complete the following steps to finish importing a schedule: 

1. Create a schedule. 

2. Go to the File menu and select Import Schedule. 

3. Select the schedule to import from. 

 
 

4. Click the Import a Schedule button. 
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5. Choose the Start/End Date of the schedule to import using the dropdown calendar menus. 

6. Enter the flight number to display by flight number. Alternatively, select the Entire Schedule check box to import 

the full schedule; or select the designators, routes and cycles to be imported then use the arrows to move 

designated items to the Selected columns . 

7. Click on the Fetch button to find the selected criteria. 

8. Select the flights to import by checking the boxes. 

9. Click on the Import button to import the schedule or the Cancel button to cancel without generating action. 

 

The following confirmation prompt will display. Click Yes to continue or No to disregard. 

 

 
 

The prompt below will appear once the import finishes successfully. 
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It is suggested that the user select a day prior to the start of a schedule and a day after the end of the schedule to 

encompass the whole schedule period. Otherwise, not all flights will be included in the schedule. 

Close Schedule 

The Close Schedule feature enables users to close a schedule.  

 

Edit Menu 

Add Flight to Cycle 

This can be used as an alternative to the Add Flight button in the toolbar and Schedule View. 

 

Add Cycle 

This can be used as an alternative to the Add Cycle button in the toolbar and Schedule View. 

Flight Information  

This can be used as an alternative to the Flight Information button in the toolbar and Schedule View. 

Delete Flight  

To delete a flight using the Delete Flight feature in the Edit menu: 

1. Select the designated flight row for deletion in the Schedule Display Panel. 

2. Click on Delete Flight from the Edit menu. 

A dialog box will appear asking the user to confirm the deletion. 

 

 
 

3. Click on Yes to confirm the deletion or No to close the dialog box without generating action. 

A second dialog box will appear if there is more than one instance of the flight in the schedule. 
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4. Select the applicable radio button from the following: 

• Just this flight instance  

• Selected instances of this flight 

• All instances of this flight  

5. Click on the OK  button to delete or the Cancel button to close the form without generating action.  
 

 

Find  

The Find tool enables the user to search for a flight within the schedule. The keyboard shortcut <Ctrl + F> generates an 

abbreviated Find Flight form as a time saving convenience.  

To use Find Flight, enter a flight number in the Flight field and click Find. 
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For a more detailed search, click the Detailed Search button and the Search Criteria form displays.   

 

To find a flight/aircraft, fill out any of the Search Criteria fields as follows:   

Field Description 

Pre-Saved Search 
Click the down arrow to access a dropdown menu of pre-saved flight searches, if 

applicable 

Add New Search Enter a name for the new search if the criteria will be saved 

Equip Type Enter the aircraft model 

Flight Designator Select the flight designator from the dropdown menu 

Flight Enter the flight number 

Operator Select airline operator from dropdown menu 

Departure Port Enter a departure port and a list will generate 

Arrival Port Enter an arrival port and a list will generate 

STD Enter the schedule time of departure using the up/down arrows 

Time Margin Adjust the time margin as a threshold of hours before and after the STD 

Client Reference If applicable, enter the client name 

 

Click the Search button to initiate the search, results will be displayed under Search Results in the form, or click Cancel 

to clear the form. 

 

Other search button options include: 

Field Description 

Save Search Saves the search criteria for future use 

Set Default Search Saves the search as the default search 

Delete Save Search Deletes the saved search from the pre-saved search menu 

View Flight Information Displays the Flight Information window for the selected flight 

Display in Flight Entry Displays the search results in the Schedule Display Panel Grid view 
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View Menu  

Time Mode 

To change time modes, select Time Mode and select one of the options below: 

 

• Zulu (Z): Zulu time is known as Greenwich Mean Time (GMT) 

• Port (L):  Port time is local time in your time zone   

• Standard (S): Standard time is local time at your company headquarters 

The selected time mode is displayed at the top of the Gantt. 

 

 
 

 

Schedule Conflict 

 
  

The Flight Conflicts form contains the following information: 

 

Field Description  

Flight Designator and flight number 

Day/Date Range Effective from/to dates of the flight schedule 

Conflict Type Displays the Conflict Type icon 

Description Description of the conflict type, in this case there is a duplicate flight instance  

Conflict Type Advises user to view flight information to fix the error or see if it is an informational flight.  

 

After reviewing items listed in the Flight Conflicts form, click Cancel to close the form and return to the Schedule Display 

Panel.     
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Tools Menu 

Manage Maintenance 

To access the Manage Maintenance feature, select Manage Maintenance from the Tools dropdown menu. 

 

 
 

Aircraft maintenance involves the overhaul, inspection, modification or repair of an aircraft or a component of an aircraft. 

Maintenance may include the installation or removal of a component from an aircraft. 

 

Aircraft maintenance checks are periodic inspections that have to be done on all commercial/civil aircraft after a certain 

amount of time or usage. The AircraftSchedule application includes the functionality to view scheduled maintenance 

events and to add, edit and delete these events. 

 

The following maintenance management options are available in the Manage Maintenance tool: 

• Find maintenance events for an aircraft 

• Maintenance Template 

• Add maintenance event 

• Edit maintenance event 

• Delete maintenance event 

 

 

Find Maintenance Event  

To find a maintenance event, using the search function in the Manage Maintenance form: 

1. Select an applicable Operator, Equipment Type and/or Equipment Rego (Registration) from the dropdown 

menus. 

2. Select the Start Date and End Date from the dropdown calendars to define a search period. 

3. Click on the Fetch button. 
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A list of the selected aircraft’s maintenance events will display in a user selectable form. This list will display only the 

maintenance events that fall within the date range selected. 

 

4. If no further action is required, click Cancel to close the form without generating action. 

 

 

Maintenance Template 
 

The Maintenance Template holds the different required maintenance types that an aircraft needs. Some basic information 

for each maintenance type can be defined in this form. To add a template: 

1. Click the Add New Maintenance Event button at the bottom of the Manage Maintenance form. 

2. Click the Maintenance Template link at the top right corner. 

The Maintenance Template form appears. 

 

 
 

3. Complete each field. 

 

Field Description 

Description The maintenance type required for an aircraft 

Equipment Type The aircraft model requiring this type of maintenance 

Duration Amount of time required to perform this maintenance type 

Max Hours The maximum number of hours the aircraft can fly before requiring this maintenance 
type again 

Max Cycles The maximum number of cycles the aircraft can perform before requiring this 
maintenance type again 

Comments Free text field that can hold notes or reminders whenever a maintenance of this type 
is scheduled 

Text Color Text color of the maintenance event in the Schedule Display Panel and the Gantt 
view 

Background Color Color of the maintenance puck 

Bottom Color Color of the bottom half of the maintenance puck 

 

4. Click Save when finished, or Cancel to discard changes. 

5. To add another row, click Add and complete each field, then Save. 

6. To delete a row, click on the row and then click Delete. Click Yes when asked to confirm, then click Save. 
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Add Maintenance Event 

To add a new maintenance event from the Manage Maintenance form: 

1. Click the Add New Maintenance Event button at the bottom of the Manage Maintenance form. 
2. Complete the required fields on the Maintenance Template. 

Required fields are marked with an asterisk.  
 

 

Field Description 

Maintenance Event 
Type 

Select the type of maintenance required. The options are taken from the 
Maintenance Template. 

Operator Select the airline operator from the list of registrations in the dropdown menu. 

Equipment Rego Select equipment registration from the list of registrations in the dropdown menu. 

Equipment Type Select equipment type from the list of types in the dropdown menu. 

Start Date Select a start date for the maintenance event from the dropdown calendar . 

End Date Select an end date from the dropdown calendar . 

Start Time Enter start time in hh:mm format. 

End Time Enter end time in hh:mm format. 

Max Hours Maximum number of flying hours before another maintenance of the same type is 
required. This is automatically populated as defined in the Maintenance Template. 

Max Cycles Maximum number of cycles before another maintenance of the same type is 
required. This is automatically populated as defined in the Maintenance Template. 

Title Name for the maintenance event. 

Location Location where the maintenance will be done, for example a hangar or ramp. 

Duration Automatically calculated by the start and end times. 
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Route Restrictions If applicable, select the check box to apply route restrictions. 

Port Restrictions If applicable, select the check box to apply port restrictions. 

Port Select the port where maintenance will take place.  

Planned Indicates if this is a planned maintenance event, if selected, or ad hoc, if not 
selected. 

Comments User entered text field for MEL related comments. 

 

3. Click on the Save button to save the event or the Cancel button to close the form without generating action.  
 

When an event is saved, the form flushes all fields to enter another event.   

 

Maintenance events are displayed in the Schedule Display Panel along with flights. 

 
 

In Gantt view, maintenance events are located at the bottom of each equipment group unless they are linked with flights 

in a cycle. 

 
 

 

 

Edit Maintenance Event 

 

To edit an existing maintenance event from the Manage Maintenance form: 

1. Select the desired maintenance event in the grid (i.e., Maintenance events shown in Fetch results). 

2. Click on Edit selected maintenance event button at the bottom of the Manage Maintenance form. 
3. The system will open the same Add Maintenance form used to add maintenance events (shown on  previous 

page). 
4. Make required changes in the Add Maintenance form. 

5. Click on the Save button to save the changes or the Cancel button to close the form without generating action.  
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Delete Maintenance Event  

To delete an existing maintenance event from the Manage Maintenance form: 

1. Select the desired maintenance event in the grid (i.e., Maintenance events shown in Fetch results). 

2. Click on the Delete maintenance event button in red at the bottom of the Manage Maintenance form. 

 

A dialog box will appear, asking the user to confirm the deletion. 

 

3. Click on the Save button to save changes or the Cancel button to close the form without generating action.  

 

The system deletes the Maintenance event.  

 

 

Run Rules  

The Run Rules feature in the Tools menu is part of future development in AircraftSchedule. 

 

Options 

User Preferences   
 

The User Preferences form allows system administrators to set up visual preferences in AircraftSchedule based on 

individual airline specifications. For instance, it is possible to change the order of fields displayed in the Schedule Display 

Panel through this template. 

 

 
 
User preference editing is restricted to administrator access. To edit preferences, click a row to select the row, modify the 

value as needed and click Save to save changes or click on Cancel to close the form without generating action. Click on 

Reset to return the user preferences to the default state. This subject is discussed in detail in the Configure User 

Manual. 

Import SSIM 

The Import SSIM feature in the Tools menu allows system users to import existing schedules in IATA’s industry standard 

format known as the Standard Schedules Information Manual (SSIM) and to have these schedules populate in the 

Schedule Display Panel.  The final schedules are marked active. 
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To import an SSIM file, select Import SSIM from the Tools menu. 

1. Click the Browse button, locate the SSIM file.  
2. Click on the Import button to import the SSIM file, alternatively click Cancel to close the form without

 generating action.  

3. The dialog box below indicates that the SSIM file has been queued for processing. Click OK. 

 

 
 

4. A message will be sent in the user’s inbox when the job is finished processing. The image below shows that all 

flights in the SSIM file were successfully processed. 
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The prompt below shows that some flights were not imported. 

 
 

 

Administrator Note 

The SSIM Import Job (Import.SSIMImportJob) must be set to active and has the correct database 

credentials. 

 

Cycle Flights  

The Cycle Flights feature in the Tools menu is part of future development in AircraftSchedule. 

 

Import OAG Schedule  

The Import OAG Schedule feature in the Tools menu allows system users to import an Official Airline Guide (OAG) 

schedule into AircraftSchedule. The OAG contains published airline schedules. 

 

Refer to the import process detailed above for SSIM files. The same import process applies for OAG files.   
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Reports 

Schedule Cycle Report 
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Schedule Summary Report 

 
 

 

Timetable Report 
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Export SSIM 

 
 
The steps to complete the Export SSIM dialog box are as follows: 

The Schedule Name is pre-populated based on the last schedule worked on. 

1. Enter Date From and Date To dates using the dropdown calendars. 

2. Select Time Mode either L-Port or Zulu time (GMT) time from the dropdown menu. 

3. Enter the FTP address with file name in the Export To field. 
If the export path is not entered, the job will fail; 

If the export path does not have a file name, the job will add a file name based on the current date and time; 

If the export path has a file name but no file extension (.ssim), the job will fail since it will assume that only a 

path is given; 

If the export path has a file name and file extension, the job will run successfully. 

4. Click on the OK button to export the SSIM file. Alternatively, click Cancel to close the form without generating 

action.  
 

Note: The ExportSSIMJob needs to be activated and configured with the FTP server credentials. 
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Application Flow Diagram 

  

 

Configure application is a central place where all crew and aircraft configuration information can be 

accessed. The application defines the core set of configuration requirements that are the building 

blocks that allow merlot applications to be used in the way required by your airline. 

AircraftSchedule improves the development of flight schedules while ensuring operational integrity 

and meeting the needs of airlines for increased efficiency in scheduling. The application includes a 

maintenance planning capability. 

CrewBuild develops efficient crew pairings that achieve business goals while meeting the needs of 

crew and managing changes that arise after the roster is published. 

CrewPlan plans and monitors all revalidation and qualification checks, medicals, license renewals, 

annual leave and administrative needs. Crew shortfalls or surplus information is accurately 

calculated by fleet, rank or base and can be aggregated at daily, weekly or monthly levels. This 

extends to future establishment planning. 

The CrewRoster application allows the user to develop efficient crew rosters that achieve business 

goals while meeting the needs of crew.  

CrewFollow provides airlines with the best information to act on in response to crew disruptions 

resulting from (amongst other things) sickness, no-shows and crew-related disruptions on the day. 

CrewMonitor identifies and monitors changes within merlot for disruptions that will impact pairings 

and pairing allocations to crew members. 

CrewPortal and CrewMobile provide airline crew with the ability to view the latest crew related 

information on a computer or mobile device such as phones or tablets. It enables airline operations 

employees to securely distribute timely and relevant information to crew members including duty 

assignments, duty changes and messages. 

AircraftFollow provides a real time graphical representation of your airline’s live status for the day. 

AircraftFollow allows the user to manage incoming and outgoing aircraft and related operational 

tasks on a day-to-day basis. The application provides accurate and timely information to improve 

the decision support process. 

AircraftPortal and AircraftMobile provide outstations with the ability to view the latest schedules and 

fight-related information on a computer or mobile device. Updates to departure and arrival times, 

terminals, gates and bays can be done from here. These also allow management a quick look at 

the day’s operations. 

 

CrewPayroll manages complex pay and allowance calculations for crew. 

The ExecutiveDashboard provides executive level reporting including key performance indicator 

(KPI) data to help airlines gauge operational and employee success.  

Configure 

AircraftSchedule 

 

CrewBuild 

 

CrewPlan 

CrewRoster 

CrewFollow  

 

CrewMonitor 

CrewPortal, 
CrewMobile 

AircraftFollow 
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AircraftSchedule Glossary 

Term Definition 

Aircraft 

Utilization 

Measure of aircraft productivity calculated by dividing aircraft block hours by the number of 

aircraft days assigned to service on air carrier routes. Typically presented in block hours per 

day. 

AOC Air Operator's Certificate 
Also referred to as Operator or Operator Code 
 

The AOC is the approval granted by a national aviation authority (NAA) to an aircraft operator 

to allow it to use aircraft for commercial purposes. This requires the operator to have 

personnel, assets and system in place to ensure the safety of its employees and the general 

public. 

Arrival Time The time the aircraft arrives at the specified port. There are three sets of arrival times used in 
the system: 

• Scheduled time of arrival (STA) - the original arrival time 

• Estimated time of arrival (ETA) - the expected time of arrival. This can change 
depending on the performance of the previous flights. 

• Actual time of arrival (ATA) - the exact time the aircraft stops 

Base The port to which crewmembers are expected to commence and finish their tasks / activities. 

Block Hour Also called block time, blocks or flight hours 
 
The time from the moment the aircraft door closes at departure of a flight until the moment the 
aircraft door opens at the arrival gate following its landing. Block hours are the industry 
standard measure of aircraft utilization (see above). Many airlines consider a block hour to be 
from the time the chocks are removed from the wheels of a departing aircraft, after doors 
have been closed, until the time the chocks are put in place at the wheels after arrival at the 
airport gate before the doors are opened. 

Cargo Goods carried by the airline not associated to a passenger. 

Company Time This refers to the time at which the pairing or event is occurring converted to the company’s 
base or headquarters location 

Crew A specific type of employee required for flight operations. This term is interchangeable with 
employee. 

Crew 

Complement 

The number and types of crew required for a pairing. 

Currency 
Requirements 

Also called recency requirements 
Pilots need to meet certain currency requirements in order to remain legal to operate. These 
can include instrument currency, night currency, various approach currencies, etc. 

Department The areas within an airline or company that are tasked with providing particular services of a 
similar type. For example, in an airline there are Flight Operations (i.e. the manning and 
operating of aircraft), Maintenance (ensure the aircraft were able to operate safely), and 
Ramp (the parking and coordination of aircraft resupply between flights). 
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Departure Time The time the aircraft departs from the specified port. There are three sets of arrival times used 
in the system: 

• Scheduled time of departure (STD) - the original departure time 

• Estimated time of departure (ETD) - the expected time of departure. This can 
change depending on the performance of the previous flights. 

• Actual time of departure (ATD) - the exact time the aircraft stops 

Designator Unique alphanumeric code given to distinguish each airline, or operations within an airline 

Equip Config Each equipment type can have more than one configuration for seats and cargo. This will 
affect the assignment of flights to aircraft rego/tails. 

Equipment 

Group 

The grouping of a similar set of equipment types. For example, a 737 which could be 
comprised of 733 and 734 equipment types. 
 
This can also be used as a reference to indicate the equipment types that a crewmember is 
legal to operate on as part of his rating. 

Equipment Type Also called aircraft type. 
 
Model of the aircraft. A specific type of aircraft that has distinct characteristics, for example a 
733 or 734. 
 
This can also be used as a reference to indicate the equipment types that a crewmember is 
legal to operate on as part of his rating. 

Flight Also called sector 
 
The transport taken from a departure point to an arrival point. 

Flight 

Complement 

The number and types of crew required to operate a flight. 

Flight instance A specific flight on a specific date. This term is used for flights that are recurred through a 
specified period. 

Flight sequence A series of flights in a chronological flow for one equipment type or an aircraft/tail 

Gantt A Gantt chart, commonly used in project management shows you what has to be done in 
terms of activities, tasks and events and when in terms of scheduled dates and time. 

Gate The location at the airport where passengers embark and disembark. 

GMT Greenwich Mean Time 
Also called Zulu time 
 
The time at location at which the pairing or event is occurring converted to Greenwich Mean 
Time (GMT) value. 

Local Time The time at the location at which the pairing or event is occurring. If the location is the same 
or in the same time zone as the company base or headquarters location this time will be the 
same as the company value. 

Mark as Active Also called Activate Schedule 
 
Defines the schedule as able to be used within the rest of the merlot application suite. Similar 
to publishing a schedule in order to be used across the system. 
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Onward flight A field where users can link one flight to another to form a chronological sequence of flights. 

The onward flight may occur on the following day, but never before the flight’s date. 

Port An airport or station 

Puck The graphical representation of a flight or pairing in a Gantt chart. 

Rating (or Type 

Rating) 

Defines the combination of equipment and position that personnel can legally operate. In 

merlot, the characteristics that define a rating are: Rank, and Equipment Group. 

Recurrent flight A flight that operates the same flight number, route and timings on more than one day 

Route A course between two ports, for example BNE-SYD 

Schedule A timetable of flights 

Standard 

Schedule 

Information 

Manual 

A message file that contains a flight schedule for several months. This is commonly used to 

send a seasonal schedule from one system to another. 

System The merlot.aero software application. 

Turnaround Also called Actual Turnaround, Scheduled Turnaround, Turnaround Time 
 

Amount of time between the arrival of a flight and its departure from a port. This is also the 

time taken to unload passengers, baggage, cargo, etc. upon arrival and to board passengers 

and load baggage, cargo, etc. before departure 

User A person who has access to view and/or modify data in the system 

Violation 

Behavior 

This determines what can be done to a violation once it is flagged. This works in conjunction 
with violation severity. 

• Inviolate - does not allow the assignment to push through no matter what 

• Override - if the user has the appropriate security rights, he can override the violation 

• Override Disrupt - if the user has the appropriate security rights, he can override the 
violation only if the flight is in disrupt 

• Track - the user can proceed with the roster changes but the violation is retained for 
tracking purposes. The violation will not have a pop up, but will be visible in the 
Violation Panel. 

• Ignore - the violations are retained in the Violation Panel 

Violation 

Override 

This determines how a violation should be overridden 

• Management - the credentials of a management-level user must supply his 
credentials when overriding the violation 

• Supervisor - a supervisor must supply his credentials when overriding the violation 

• Extension - a user with override rights must supply his credentials when overriding 
the violation which consequentially allows an extension to the flight hours, duty hours 
and/or flight duty period 

• Discretion - signifies that the violation will be overridden based on the captain's 
discretion 

Violation 

Severity 

This determines how a violation is presented 

• Critical - the violation must be addressed. Otherwise, the crew is illegal to fly 
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• Ignorable - the violation can be addressed later and will not prevent the crew from 
reporting for a duty 

• Informational - the rule breach is for informational purposes only 

• Passed - the rule is not breached and nothing has to be done 
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Notes 


